
 i  
 

 

 

ISSUE :  1.0 
UPDATE : 04.2004 

 

 



 i  
 

 
1360 Route des Dolines, Les Cardoulines – Bâtiment B4, 06560 Valbonne - FRANCE 

Tel : +33.(0)4.97.21.33.10 , Fax: +33.(0)4.97.21.33.11, email : info@one-rf.com 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Proprietary Notice: 
© Copyright One RF Technology 2004 

The information in this document is subject to change without notice. 

Company or product names mentioned in this document may be trademarks or registered trademarks 
of their respective companies. 
All rights reserved. Neither the whole nor any part of the information contained in this publication may 
be reproduced in any material form except with the written permission of One RF Technology. 
 
This publication is intended only to assist the reader in the use of the product. One RF Technology 
shall not be liable for any loss or damage arising from the use of any information in this publication, or 
any error or omission in such information, or any incorrect use of the product. 
 
 
Technical Support: 

Documentation is updated periodically. For the latest information about One RF Technology products, 
including software upgrades and application information, please visit One RF Technology’s website at 
the following internet URL: 
http://www.one-rf.com/ 
 
Documentation and software are periodically released on a CD-ROM, called Master CD, gathering all 
documentation and latest version of software for One RF Technology products. For the latest version 
of the Master CD, please contact your local One RF Technology Sales entity. One RF Technology Sales 
entity are available on One RF Technology website. 
 
 
One RF Technology provides customer technical support using phone and/or e-mail means. For 
customer technical support, please contact your local One RF Technology Sales entity.  
 

 

 ii  MTC Workbench manual 

 

 
 

TABLE OF CONTENTS 
 
 
 
 

CHAPTER I. INTRODUCTION ..............................1 
I.1. AIM OF DOCUMENT.............................................1 
I.2. SOFTWARE & MANUALS .......................................1 
I.3. PRODUCT OVERVIEW ...........................................2 
I.4. SOFTWARE INSTALLATION (WINDOWS) .....................2 

CHAPTER II. INITIALISATION PROCESS ..............3 
II.1. INITIALISATION ................................................3 
II.2. AUTO-CONFIGURATION .......................................4 

CHAPTER III. BASIC USER LEVEL DESCRIPTION...5 
III.1. THE DESKTOP.................................................5 
III.2. THE MENU BAR .............................................6 
III.3. THE TOOL BAR................................................8 

CHAPTER IV. ADVANCED USER LEVEL 
DESCRIPTION ..................................................9 

IV.1. THE DESKTOP .................................................9 
IV.2. THE MENU BAR.............................................. 10 
IV.3. THE TOOL BAR .............................................. 13 

CHAPTER V. THE APPLICATION TREE ................ 14 
V.1. ‘TREE’ WINDOW DESCRIPTION ............................ 15 
V.2. ‘TREE’ WINDOW OPERATION .......................... 17 
V.3. ‘ABOUT PORTS’ WINDOW................................... 18 

CHAPTER VI. CHANNEL SCANNING................... 19 

CHAPTER VII. PEER-TO-PEER DIALOG .............. 21 
VII.1. CONFIGURATION ...........................................21 
VII.2. PEER-TO-PEER DIALOG TOOL ...........................22 
VII.3. REMOTE PEER-TO-PEER DIALOG TOOL.................26 

CHAPTER VIII. NETWORK DIALOG.................... 30 
VIII.1. CONFIGURATION ..........................................30 
VIII.2. NETWORK DIALOG TOOL ................................32 

CHAPTER IX. TERMINAL .................................. 34 
IX.1. TERMINAL TOOL .............................................34 
IX.2. TERMINAL CONFIGURATION................................36 

CHAPTER X. RADIO MODULES CONFIGURATION 39 
X.1. DISPLAYING A CONFIGURATION ...........................39 
X.2. CONFIGURING A RADIO MODULE ..........................41 
X.3. CREATING A NEW CONFIGURATION FILE .................42 
X.4. SAVING A CONFIGURATION.................................45 

CHAPTER XI. PROGRAMMING........................... 47 

CHAPTER XII. APPENDIX ................................. 49 
XII.1. DOCUMENT HISTORY .................................49 
XII.2. SOFTWARE HISTORY ..................................49 

 

 
 
 
 
 
 
 

mailto:info@one-rf.com
http://www.one-rf.com/


Introduction 1  
 

 

CHAPTER I.  INTRODUCTION 

I.1.  AIM OF DOCUMENT 

 
The aim of this document is to present the features and functionalities of One RF 
Technology's radio Modules Test and Configuration (MTC) Workbench software. 
The MTC Workbench will be described within: 
Ø An introduction chapter about the software and its installation 
Ø A chapter describing the initialisation process 
Ø Three chapters presenting the user interface 
Ø Five chapters describing the software’s basic and advanced operation 
Ø A set of appendix to assist the user in the software operation 

 
 

I.2.  SOFTWARE & MANUALS 

The different functioning modes and the use of the registers, illustrated by many 
examples, are fully described in the "Functionalities & Operating Modes" manual. 
 
Each board and modem have a separate technical manual including the 
datasheet for radio, electrical and mechanical data, as well as complementary 
details on the use of the board/modem in the different functioning modes. This 
manual will be updated more often than the general ones, so please use it for 
accurate information. 
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I.3. PRODUCT OVERVIEW 

  
The radio Module Test & Configuration (MTC) Workbench is a One RF 
software framework to test and configure all radio modules supplied by One RF 
Technology. The purpose is to supply a framework where new software 
components can be added very easily, in order to support new radio modules. 
 
Several and diversified radio modules, connected to the PC/workstation via 
various hardware interfaces (RS232, RS422, ...), can be tested and configured 
at the same time. The framework provides a desktop to display, test and 
configure multiple units with a standard set of functions, common for all radio 
modules.  
 
It also provides an interface to add radio module specific functions, supplied by 
the radio module specific software plug-in, to the framework. 
 
The software is based on JAVA / Swing technology in order to support several 
OS platforms. MTC Workbench software is compatible with most Windows OS 
(i.e. 98, 2000, XP from Service Release 3) but is not compatible with Windows 
Millenium Edition (it is a ‘home’ OS and does not recognise serial ports). 

 
 

I.4. SOFTWARE INSTALLATION (WINDOWS) 

 
1. Put the One RF Master CD into the PC. The CD is autolaunched and displays a 
browser on the One RF database page. 
 
2. Go to any product page by clicking on the corresponding link. 
 
3. Install the MTC Workbench software by clicking on the “MTC Workbench 
Installation” link. The software is automatically installed in “C:\Program 
Files\One RF\MTC\” (this directory can be changed). 
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CHAPTER II.  INITIALISATION PROCESS 

II.1. INITIALISATION 

 
When the program is launched, it calls an application configuration file, stored in 
one of its data directories, in order to determine the type of serial ports, radio 
modules and modems or interface characteristics (i.e. graphic layout 
characteristics) the software should feature. 
 
Once all the necessary information has been found in the configuration file, a 
first desktop, including the One RF Technology logo and the software version, is 
displayed along with a check message allowing the user auto-configuring his 
serial ports, i.e. detecting radio modules and/or modems: 
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If no radio module (i.e. board, radio module or demo kit) is connected to the PC 
from which the MTC software is operated, the auto-configuration step can be 
bypassed by clicking on ‘No’. The software operation desktop (described in 
paragraphs 3.1 and 4.1)  is then displayed. 
 
If one or several radio modules are connected to the PC, the auto configuration 
needs to be launched for the software to recognise and detect those units. A 
click on ‘Yes’ launches the auto-configuration. 
 

II.2. AUTO-CONFIGURATION 

 
Once the auto configuration is launched, the software asks the system the 
number of communication ports it contains as well as their denomination and 
tries to detect any radio module connected to it. This detection results in the 
auto configuration process and can be described as follows: 

  
Ø It scans the different serial port parameters that can be used to 

configure any type of radio module : speed from 1.2 to 115.2 Kbps, 7 
and 8 data bits, 1 and 2 stop bits, none, even and odd parity. The flow 
control is set from the board's parameters after the detection is finished. 

 
Ø For each value of bit rate, all the values of parity are tested. For each value of 

parity, all the values of data bits are tested.  
 

Ø Once a serial port configuration allows communicating with the radio module, 
the loop is exited and that configuration is stored. 

 
The software sends a +++ message to check if a radio module is connected on 
each port. If no answer is received (i.e. no radio module connected) after a time 
out, the software tries to configure the other serial ports with the same 
procedure described above, following the order defined by the system (e.g. 
numerical order: COM1, COM2, then COM3, etc). 
 
If an answer is received (i.e. a radio module is connected), the port is 
configured, and the software tries to detect other radio modules on the next 
serial port, following the numerical order of the ports. 
 
If the user needs to interrupt the auto-configuration for any reason (E.g. more 
ports than needed defined in the system), the ‘INTERRUPT’ button needs to be 
clicked. The following confirmation message is then displayed: 

 
Clicking on ‘No’ continues the auto configuration where it was interrupted. 
Clicking on ‘Yes’ confirms the interruption (effective when the current auto 
configuration is done) and displays the following message: 

 
Clicking on ‘OK’ ends the auto configuration and displays the software’s 
operation desktop, described in the following paragraph.  
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CHAPTER III.  BASIC USER LEVEL DESCRIPTION 

This chapter describes the main aspects of the MTC software’s user interface 
configured in basic user level. This basic user interface allows quick 
configuration and dialog between two compatible radio modules as well as some 
basic and common functions such as auto configuration and channel scanning. 
 
The description goes through three paragraphs presenting the desktop, the 
menu bar and the tool bar. 
  

  

III.1. THE DESKTOP 

 
Once the auto configuration is done, or if it was interrupted, the operation 
desktop is displayed: 
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 The operation desktop includes two windows used for the software operation 
and which can not be closed: The ‘Tree’ window, containing all the information 
for the software operation, and the ‘About Ports’ window, giving the status of 
every serial port during the software operation, are described in chapter V. 
As many software, it is also composed of the following elements: 
 

Ø A menu bar: It allows the user to access a standard set of functions and 
options to operate the MTC software. It is described in chapter III.2. 

 
Ø A tool bar: It contains different buttons corresponding to the main 

functions and options of the menu bar. It is described in chapter III.3. 
 

III.2. THE MENU BAR 

 
Each menu is composed of several submenus corresponding to specific functions 
or actions. Every menus and submenus are described in the following 
paragraphs. Each function and option will be further described in the next 
chapters. 

 

• The ‘File’ Menu 
  

The ‘File’ menu is composed of ‘Exit’, a submenu which quits the software 
program. 

 

• The ‘Settings’ Menu 
 

The ‘Settings’ menu is composed of the following submenus: 
 

Ø Language: Allows the user to change the software’s operation language 
(English and French are available for the moment). The default language 
is English. 

 
Ø User level: Allows the user to switch from a basic operation desktop to 

an advanced operation desktop and vice-versa. The menus available 
depend on the chosen level: 

 

MENUS File Settings Modem Tools Peer-to-
peer 

Network Windows Prog. Help 

BASIC LEVEL ü ü ü - ü ü ü - ü 
ADVANCED LEVEL ü ü ü ü - - ü ü ü 

 

• The ‘Modem’ Menu 
 

The ‘Modem’ menu is composed of the following submenu: 
 

Ø Channel scanning: Displays a window which presents either the radio 
channel’s occupation rate or the signal’s level received by the radio 
module. The channel scanning function is described in Chapter VI. 

 
Ø Autoconfiguration: Allows the user to launch an autoconfiguration on 

one or on all ports from the desktop (e.g. for connection loss or modem 
replacement). 
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• The ‘Peer-to-peer’ Menu 
 

The ‘Peer-to-peer’ menu is for basic operation configuration and is composed of 
the following submenus: 
 

Ø Configuration: Displays a window allowing quick configuration of two 
radio modules for peer-to-peer dialog. The parameters concerned are 
the operating mode and the radio channel. 

 
Ø Dialog: Displays an advanced terminal dialog window between two 

given radio modules, the ports of which are chosen by the user.  The 
peer-to-peer dialog window is described in chapter VII.2. 

 

• The ‘Network’ Menu 
 

The ‘Network’ menu is composed of the following submenus: 
 

Ø Configuration: Displays a window allowing quick configuration of two radio 
modules for network dialog. The parameters concerned are the operating 
mode (Network client, server or addressed secured), the network and clients’ 
IDs, and the radio channel. 

 
Ø Dialog: Displays an advanced terminal dialog window between two given radio 

modules already configured with all necessary network parameters (i.e. mode, 
network and clients’ IDs). The ports are chosen by the user. It is described in 
chapter VIII.2. 

 
 

• The ‘Windows’ Menu 
 

The ‘Windows’ menu lists the different windows already opened and allows the 
user to change the active window. Note that both ‘Tree’ and ‘About ports’ 
windows will always appear in that list as they can not be closed. 

 

• The ‘Help’ Menu 
 

The ‘Help’ menu is composed of an ‘About’ submenu which displays a window 
containing all information about the software development such as software 
version, copyright, author, etc: 
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III.3.  THE TOOL BAR 

 
The tool bar contains shortcut buttons corresponding to the main functions of 
the menu bar described in the previous paragraph. Some of those are only 
applicable in certain conditions and are therefore disabled (greyed) when not 
available. 

 
 

    
The buttons’ functions are listed in the following table. 

 

 Name Function / Action 

 Channel scanning Channel scanning of the current radio module 

 Auto-configuration Operates new auto configuration on all or selected ports 

 Opens  basic  
peer-to-peer dialog Opens peer-to-peer dialog window between two chosen ports 

 Opens basic 
network dialog Opens network dialog window between two chosen ports 

 

1 2 3 4 

1 

2 

3 

4 
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CHAPTER IV.  ADVANCED USER LEVEL DESCRIPTION 

This chapter describes the main aspects of the MTC software’s user interface 
now configured in advanced user level. This advanced user interface allows 
advanced configuration, basic and remote dialog between two compatible radio 
modules, modem functions (auto configuration, channel scanning), advanced 
tests and evaluation with the improved Terminal interface. 
  
The description goes through three paragraphs presenting the desktop, the 
menu bar and the tool bar. 

  
   

IV.1. THE DESKTOP 

 
Once the auto configuration is done, or if it was interrupted, the operation 
desktop is displayed: 
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 The operation desktop includes two windows used for the software operation 
and which can not be closed: The ‘Tree’ window, containing all the information 
for the software operation, and the ‘About Ports’ window, giving the status of 
every serial port during the software operation, are described in chapter V. 

 
As many software, it is also composed of the following elements: 

 
Ø A menu bar: It allows the user to access a standard set of functions and 

options to operate the MTC software. It is described in chapter IV.2. 
 

Ø A tool bar: It contains different buttons corresponding to the main 
functions and options of the menu bar. It is described in chapter IV.3. 

 

IV.2. THE MENU BAR 

 

 
 

 
Each menu is composed of several submenus corresponding to specific functions 
or actions. Every menus and submenus are described in the following 
paragraphs. Each function and option will be further described in the next 
chapters. 
 

• The ‘File’ Menu 
  

The ‘File’ menu is composed of the following submenus:  
 

Ø New: Allows the user to create either a radio module or a port. Creating a 
radio module means that the user chooses a radio module configuration file to 
load in the given connected radio module, configuring it; while creating a port 
allows the user to define a configuration for a given serial port. 

 
Ø Open: Allows the user to open a specific radio module configuration file. 

 
Ø Close: Closes the active window. 

 
Ø Save: Saves the active window. Note that only radio module files can be 

saved. 
 

Ø Save as: Saves the active window as a new file which extension is checked to 
be of the right type. 

 
Ø Print: Prints the data contained in the active window. 

 
Ø Exit: Quits the software program. 
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• The ‘Settings’ Menu 
 

The ‘Settings’ menu is composed of the following submenus: 
 

Ø Language: Allows the user to change the software’s operation language 
(English and French are available for the moment). The default language is 
English 

 
Ø User level: Allows the user to switch from a basic operation desktop to an 

advanced operation desktop and vice-versa. The menus available depend on 
the chosen level: 

 

MENUS File Settings Modem Tools Peer-to-
peer 

Network Windows Prog. Help 

BASIC LEVEL ü ü ü - ü ü ü - ü 
ADVANCED LEVEL ü ü ü ü - - ü ü ü 

 
 

• The ‘Modem’ Menu 
 

The ‘Modem’ menu is composed of the following submenu: 
 

Ø Autoconfiguration: Allows the user to launch an autoconfiguration on one or 
on all ports from the desktop 

 
Ø Channel scanning: Displays a window which presents either the radio 

channel’s occupation rate or the signal’s level received by the radio module. 
The channel scanning function is described in chapter VI. 

 
Ø Modem Configuration: Allows the user to open a window to configure a 

given radio module type: the default configuration file is displayed. The ‘Save 
as’ submenu is then to be used so that the default file does not change. 

 
Ø Serial port: Allows the user to open a window to configure a chosen serial 

port. A port can not be configured if a modem is connected. 
 
 
 

• The ‘Tools’ Menu 
The ‘Tools’ menu is composed of the following submenus: 

 
Ø Terminal: Displays a terminal window on a chosen port to operate within a 

given radio module. The terminal window is described in chapter IX. 
 

Ø Terminal configuration: Displays a window within which the user can 
configure several buttons to simplify the use of the terminal window (E.g. 
buttons for ‘AT’ commands). The terminal configuration window is described in 
chapter IX.2. 

 
Ø Peer-to-peer dialog: Displays an advanced terminal dialog window between 

two given radio modules, the ports of which are chosen by the user.  The peer-
to-peer dialog window is described in chapter VII.2.  

 
Ø Remote peer-to-peer dialog: Displays an advanced terminal dialog window 

between two given radio module connected on two different PCs, the ports of 
which are defined by the user. The remote peer-to-peer dialog window is 
described in chapter VII.3. 
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• The ‘Programming’ Menu 
 

The ‘Programming’ menu includes a ‘Flashing’ submenu that shall be used for 
programming. It displays a programming configuration window. Obviously, a 
modem does not need to be detected by the MTC to be programmed 

 

• The ‘Windows' Menu 
 

The ‘Windows’ menu lists the different windows already opened and allows the 
user to change the active window. Note that both ‘Tree’ and ‘About ports’ 
windows will always appear in that list as they can not be closed. 
 

 

• The ‘Help’ Menu 
 

The ‘Help’ menu is composed of an ‘About’ submenu which displays window 
containing all information about the software development such as software 
version, copyright, author, etc: 
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IV.3. THE TOOL BAR 

 
The tool bar contains shortcut buttons corresponding to the main functions of 
the menu bar described in the previous paragraph. Some of those are only 
applicable in certain conditions and are therefore disabled elsewhere. 

 

  
 
 

The buttons’ functions are listed in the following table. 
 

 Name Function / Action 

 
New Allows the user to chose to create a new port or modem 

configuration 

 Open Allows the user to open an existing configuration 

 Close Closes the current window 

 Save Saves the current window 

 Print Prints active window information/data 

 Opens port window Opens the current serial port’s window 

 Opens modem 
window Opens the current radio module’s window 

 Opens terminal 
window Opens terminal window on the current port 

 Opens terminal 
configuration Opens terminal configuration window on the current port 

 Channel scanning Channel scanning of the current radio module 

 Opens peer-to-peer 
dialog 

Opens peer-to-peer dialog window between two chosen ports 

 
Programming Opens firmware flashing window 

 
Auto-configuration Operates new auto configuration on all or selected ports 

 
 

1 2 3 4 5 6 7 8 9 10 11 12 13 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 
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CHAPTER V.  THE APPLICATION TREE 

Once the auto configuration is done, the software builds and displays the 
application tree using the serial ports defined in the system, the connected 
modems detected during auto configuration and the modem configuration files 
found in the application configuration file. 
 
The application tree is composed of two windows that cannot be closed: the 
‘Tree’ window and the ‘About Ports’ window.  

 
Note: The application tree, i.e. the Tree window especially, can not be exploited 
in basic user level configuration. In basic level configuration, the Tree is just 
used as information. 
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V.1. ‘TREE’ WINDOW DESCRIPTION 

• The COM ports 
 

As shown on the previous pictures, the ‘Tree’ window is composed of two distinct 
parts. The first part (named ‘Serial port’) lists all the serial ports detected by the 
system during the initialisation process: 
 

 
 

Ø When a radio module is connected to the port, a node ( ) appears besides the 
port name. When clicked, that node makes the module’s type appears as a 
child node of the port node: 

 

 
Ø When a configuration file is assigned to a radio module, it appears as a second 

child node of the port node: 
 

 
 

Ø When a tool is operated on a radio module, it also appears as a second child 
node of the port node: 
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Ø When a tool and a configuration file are applied to a radio module, they both 

appear as child nodes of the port node: 

 
 

• The configuration files 
 

The second part of the ‘Tree’ window’ (named ‘Configuration files’) lists the 
different configuration files, sorted by radio module type, found by the software 
during the initialisation process: 

 

 
Legend: 

: Boards configuration files 

: Modems configuration files 

: Modem and board common configuration files 

: Obsolete modules configuration files 
 

Ø When a configuration file has been found by the software, a node ( ) appears 
besides the radio module type’s name. When clicked, that node makes the 
configuration file’s name appears as a child node of the module type node: 
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V.2. ‘TREE’ WINDOW OPERATION 

 
Each node can be expanded or reduced with a left-click (the node is not 
selected) or with double-click on its name or its icon (the node is selected). 
 
The window also includes some right-click ‘pop-up’ menus to access functions 
and options of the menu or the tool bar. Those menus are accessible from the 
‘Tree’ with a right-click on the node name. Below are listed the pop-up 
submenus available from the ‘Tree’, when applicable 

 

Ø     
â N/A 

 

Ø    
â ‘Autodetect’ submenu: launches auto configuration 

 

Ø     
â ‘Assign’ submenu: Displays a browse window to assign configuration file 

to the module connected on COM i. 
â ‘Deassign’ submenu: Deassigns the configuration file from the module 

connected on COM i. 
â ‘Autodetect’ submenu: launches auto configuration on COM i only. 
â ‘Properties’ submenu: displays COM i properties window 

 

Ø     
â N/A 

 

Ø   
â N/A 

 

Ø    
â ‘New’ submenu: displays a browse window to create a configuration file 

 

Ø   
 

â ‘Open’ submenu: displays configuration file window 
â ‘Save as’ submenu: displays browse window to save a new file 
â ‘Print’ submenu: N/A. Shall print configuration file window.  

  
 

Note:  A file can also be assigned by a simple ‘Drag & Drop’ of the file on the 
chosen port. 

 

 18  MTC Workbench manual 

 

V.3. ‘ABOUT PORTS’ WINDOW 

   
The ‘About port’ window gives information about the status of each serial port 
detected by the system during auto configuration: 

 
 

OPEN  Modem connected to corresponding port. Port in use  
 (E.g. a tool is operating on that port.) 
 
CLOSED Modem connected to corresponding port. Port not in use 
 
NOT CONNECTED  No modem connected to corresponding port 
 

 
Note: The legend (i.e. ports status) can be hidden by disabling the ‘Legend’ 
button. 

 

System’s Serial Ports Ports color signification legend 1 2 

2 

1 
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CHAPTER VI.   CHANNEL SCANNING 

 
The first and simplest tool available on MTC software is the channel scanning 
tool. It allows the user measuring the noise occupation ratio on each channel of 
the frequency band used by the radio modules. It can be operated either from 
the tool bar or from the menu bar. 
 
This function is not available on all modems and boards. It will be greyed if this 
feature is not included in the modem detected. 
  
From the menu bar, the ‘Modem/Scanning’ submenu has to be selected. The 
following window is displayed, allowing the user to choose the serial port on 
which the scanning has to be operated: 
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Once the choice is made, the following scanning window is displayed: 

 

 
 

Below is the description of the scanning window: 
 

Ø The title indicates what kind of modem and which port is scanned 
 

Ø The Y-axis states the occupation ratio, in % 
 

Ø The X-axis states the radio channels of the frequency band in use 
 

Ø The columns represent the occupation ratio for each channel 

• The grey part of the columns represents the maximum value of the 
occupation rate since beginning of scanning 

• The green part indicates a noise ratio lower than 30 % 

• The red part indicates a noise ratio higher than 30 % 

 
Ø The ‘Reset Max’ button, resets the maximum reached (grey areas) to null. 

 
Ø The ‘exit’ button closes the window 

 
 

Therefore, the scanning window shown above allows the user to: 
 

Ø Check if any radio module is operating on any of the radio channels of the 
frequency band in use, being aware that the scanning period is 1s. 

 
Ø Know the occupation ratio for each radio channel 

 
Ø Check if any radio disturbances are occurring on any channel of the frequency 

band 
 

Ø Choose which channel the radio module has to be operated on 
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CHAPTER VII.  PEER-TO-PEER DIALOG 

The second tool available with the MTC software is the peer-to-peer dialog tool, 
allowing the user to communicate between two compatible radio modules. In 
basic user level configuration, it consists in a distinct menu allowing quick 
configuration and dialog. In advanced user level configuration, it is part of the 
tool menu and can also be feature as a remote tool between two separate PCs.  

VII.1. CONFIGURATION 

• Basic User Level 
 

From the menu bar, the ‘Peer-to-peer/Configuration’ submenu has to be 
selected. A window allowing the user configuring two compatible radio units for 
peer-to-peer dialog is displayed: 
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Both operating mode and communication channel should be chosen by the user. 
Once the configuration is done, pressing ‘OK’ or ‘DIALOG’ allows the user to 
validate it: 

 
 

If ‘OK’ was pressed, pressing ‘Yes’ quits the peer-to-peer configuration window 
and the user has then to select the peer-to-peer dialog tool either from the 
menu bar or the tool bar. 
If ‘DIALOG’ was pressed, pressing ‘Yes’ opens the peer-to-peer dialog window 
(See chapter VII.2). Pressing ‘No’ cancels the configuration in both cases. 

 

• Advanced User level 
 

There is no peer-to-peer configuration feature in advanced user level. The 
configuration should be done directly on the radio units via their configuration 
files (See chapter X.2). 

 

VII.2. PEER-TO-PEER DIALOG TOOL 

• Tool Operation 
 

From the menu bar, the ‘Tool/Peer-to-peer dialog’ (Advanced user level) or the 
‘Peer-to-peer/Dialog’ (Basic user level) submenu has to be selected. A window 
allowing the user choosing on which ports the peer-to-peer dialog tool has to be 
operated is displayed. The same window is displayed when using the tool bar. 
 
Once the choice is validated by the user, the following peer-to-peer dialog 
window is displayed: 
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The peer-to-peer dialog window is composed of two identical panels, one for 
each module. The different fields and buttons of those panels are described 
below: 

 
Ø Title: displayed on top of the panel, it gives the type of module and the port it 

is connected to (E.g. MC-V3@COM1) as well as its function, when applicable 
(i.e. Master or slave) 

 
Ø ‘Received data’: This non-editable field displays the data received on the radio 

link from the other module. The red dot indicates the status of the 
communication: it goes to green if a message is being received. 

 
Ø ‘Nb msg’: Provides the number of messages received by the module since the 

beginning of the dialog. 
 

Ø ‘Data to send’: Displays the data to be sent by the user to the other module. 
The red dot indicates the status of the communication: it goes to green when a 
message is being sent. 

 
Ø ‘Frame length’: Provides the length of the frame to be sent by the user. 

 
Ø ‘Send continuously’: Enabling this option allows the user to transmit data 

(from ‘Data to send’) permanently to the other modem. The time out (i.e. 
‘Each […] ms’ field) is configurable but should be greater than 500 ms. 

 
Ø ‘Auto reply’: Enabling this option allows the user to send every received frame 

back to the transmitter. 
 

Ø  ‘Elapsed time’: Specifies how long the modem has been transmitting when the 
send continuously option is enabled. 

 
Ø  ‘Send’ button: Sends the frame previously entered by the user in the ‘data to 

send’ field to the other module. 
 

Ø ‘Clear Send’ button: Clears the ‘data to send’ field as well as the ‘received 
data’ field of the other module. 

 
Ø ‘Stop’ button: Stops a permanent transmission (when ‘send continuously’ is 

enabled). 
 

The two other buttons at the bottom of the window are general for both 
modules: 

 
Ø ‘Display’ button: Displays a summary of the dialog established between the 

two radio units: 

 
 

Ø ‘Clear All’ button: Clears all the window’s fields (described above). 
 

Ø ‘Exit’ button: Quits the peer-to-peer dialog window. 
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• Acquisition process 
 

When using the dialog tools with Spread Spectrum units (i.e. B/M900SS-xxx, 
B433YY-10), an acquisition step needs to be executed in order to determine the 
operation mode of each modem (i.e. Slave/Master or Client/Server, as well as ID 
numbers). This acquisition step requires given configuration of modules. In 
advanced user level configuration, those configurations have to be done directly 
by the user on the module as advanced user level does not feature a quick 
configuration tool. 
 
Several cases can occur, displaying the following messages: 

 
Ø The acquisition is already done: 

 
  

Pressing ‘OK’ enables the Peer-to-peer dialog tool window. 
 

Ø The master network ID is null: 

 
 

Pressing ‘OK’ quits the Peer-to-peer dialog tool window and the modules 
are to be configured. 

 
Ø The units are 2 masters 

 
Pressing ‘OK’ quits the Peer-to-peer dialog tool window and the modules 
are to be configured. 

 
Ø The units are 2 slaves : 

 
 

Pressing ‘OK’ quits the Peer-to-peer dialog tool window and the modules 
are to be configured. 
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Ø The units are not 1 master and 1 slave: 

 

 
Pressing ‘OK’ quits the Peer-to-peer dialog tool window and the modules 
are to be configured. 

 
 

Ø For all other cases, the acquisition should start. Once done, the following 
message will be displayed: 

 

 
Pressing ‘Yes’ enables the Peer-to-peer dialog tool window. 

 
 

When acquisition succeeds, the parameters are not updated. Therefore, the 
following message is displayed when quitting the peer-to-peer dialog tool: 
 

 
Pressing ‘Yes’ updates the module’s parameters, pressing No aborts changes. 
 
If, for any reason, the acquisition can not be done or fails (disconnection, 
disturbances, etc), some registers need to be modified, i.e. all registers 
corresponding to the network (or Master/Slave) management have to be check 
and modified if needed (i.e. S250s registers). 
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VII.3. REMOTE PEER-TO-PEER DIALOG TOOL 

 

• Tool Operation 
 

From the menu bar, the ‘Tool/Remote peer-to-peer’ submenu has to be 
selected. A window allowing the user to choose on which port the remote peer-
to-peer dialog tool has to be operated is displayed.  
 
Once the user validates the choice, the following peer-to-peer dialog window is 
displayed: 

 
 

 
This window is composed of only one panel (identical to the peer-to-peer dialog 
panels) which fields and buttons are described below: 

 
Ø Title: displayed on top of the panel, it gives the type of module and the port it 

is connected to (E.g. M433MC-V5 @ COM1) as well as its function, when 
applicable (i.e. Master or slave) 

 
Ø ‘Received data’: This non-editable field displays the data received on the radio 

link from the other module. The red dot indicates the status of the 
communication: it goes to green if a message is being received. 

 
Ø ‘Nb msg’: Provides the number of messages received by the module since the 

beginning of the dialog. 
 

Ø ‘Data to send’: Displays the data to be sent by the user to the other module. 
The red dot indicates the status of the communication: it goes to green when a 
message is being sent. 

 
Ø ‘Frame length’: Provides the length of the frame to be sent by the user. 

 
Ø ‘Send continuously’: Enabling this option allows the user to transmit data 

(from ‘Data to send’) permanently to the other modem. The time out (i.e. 
‘Each […] ms’ field) is configurable but should be greater than 500 ms. 
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Ø ‘Auto reply’: Enabling this option allows the user to send every received frame 
back to the transmitter. 

 
Ø ‘Comparison’: Allows comparison between the received frame and the frame 

sent from the remote unit. 
 

Ø  ‘Nb msg sent’: Provides the number of messages sent to the other module. 
 

Ø ‘Elapsed time’: Specifies how long the modem has been transmitting when the 
send continuously option is enabled. 

 
Ø  ‘Send’ button: Sends the frame previously entered by the user in the ‘data to 

send’ field to the other module. 
 

Ø ‘Clear Send’ button: Clears the ‘data to send’ field as well as the ‘received 
data’ field of the other module. 

 
Ø ‘Stop’ button: Stops a permanent transmission (when ‘send continuously’ is 

enabled). 
 

Ø ‘Open port button’: Opens the serial port to enable communication. Turn in 
‘Close port’ button when the port is open. 

 
Ø ‘Display’ button: Displays a summary of the dialog established between the 

two radio units: 
 

Ø  
 

Ø ‘Clear All’ button: Clears all the window’s fields (described above). 
 

Ø ‘Exit’ button: Quits the peer-to-peer dialog window.
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• Remote acquisition process 
 

When using the dialog tools with Spread spectrum units (i.e. B/M900SS-xxx, 
B433YY-10), an acquisition step needs to be executed in order to determine the 
operation mode of each modem (i.e. Slave/Master or Client/Server, as well as ID 
numbers). In advanced user level configuration, those configurations have to be 
done directly by the user on the module as advanced user level does not feature 
a quick configuration tool. For remote tools, the acquisition starts when the port 
is open. 
Several cases can occur, displaying the following messages: 
 

Ø The acquisition is already done: 
 

 
Pressing ‘OK’ enables the remote peer-to-peer dialog tool window. 

 
 

Ø The module is neither a master nor a slave: 
 

  
 Pressing ‘OK’ quits the remote peer-to-peer dialog tool window. 

 
Ø The module is a master, but its network ID is null: 

 

 
Pressing ‘OK’ quits the remote peer-to-peer dialog tool window. 
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Ø For all other cases, two cases can occur, displaying the following messages: 

 
o The acquisition failed and the modules need to be configured properly: 

 
 

Pressing ‘OK’ quits the remote peer-to-peer dialog tool window. 
 

o The acquisition succeeded: 

 
Pressing ‘OK’ enables the remote peer-to-peer dialog tool window. 

 
 

If, for any reason, the acquisition can not be done or fails (disconnection, 
disturbances, etc), some registers need to be modified, i.e. all registers 
corresponding to the network (or Master/Slave) management have to be check 
and modified if needed (i.e. S250s registers). 
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CHAPTER VIII.  NETWORK DIALOG 

 
For client/server communications between compatible units, the MTC features 
the network dialog tool, similar to the Peer to Peer dialog tool. In basic user 
level configuration, it consists in a distinct menu allowing quick configuration 
and dialog. In advanced user level configuration, it is part of the tool menu and 
can also be feature as a remote tool between two separate PCs.  
 

VIII.1. CONFIGURATION 

• Basic User Level 
 
From the menu bar, the ‘Network/Configuration’ submenu has to be selected. A 
window allowing the user configuring two compatible radio units for network 
dialog is displayed: 
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The operating mode, communication channel and network number should be 
chosen by the user. For addressed secured mode configuration, the clients’ IDs 
also have to be chosen by the user. Once the configuration is done, pressing 
‘OK’ or ‘DIALOG’ allows the user to validate it: 

 

 
 

If ‘OK’ was pressed, pressing ‘Yes’ quits the network configuration window and 
the user has then to select the network dialog tool either from the menu bar or 
the tool bar. If ‘DIALOG’ was pressed, pressing ‘Yes’ opens the network dialog 
window (See chapter VIII.2). 
Pressing ‘No’ cancels the configuration in both cases. 

 
 
 
 
 

• Advanced User level 
 

No dialog tool is available in advanced level. Please use the configuration tool 
and the Terminal windows to test these operating modes. 
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VIII.2. NETWORK DIALOG TOOL 

• Tool Operation 
 

From the menu bar, the ‘Tool/Network dialog’ (Advanced user level) or the 
‘Network\Dialog’ (Basic user level) submenu has to be selected. A window 
allowing the user choosing on which ports the network dialog tool has to be 
operated is displayed. The same window is displayed when using the tool bar. 
 
Once the user validates the choice, the following network dialog window is 
displayed: 

 

 
   

The network dialog window is composed of two identical panels, one for each 
module. The different fields and buttons of those panels are described below: 

 
Ø Title: displayed on top of the panel, it gives the type of module and the port it 

is connected to (E.g. MC-V3@COM1) as well as its function, when applicable 
(i.e. Server or Client N°n) 

 
Ø ‘Received data’: This non-editable field displays the data received on the radio 

link from the other module. The red dot indicates the status of the 
communication: it goes to green if a message is being received. 

 
Ø ‘Nb msg’: Provides the number of messages received by the module since the 

beginning of the dialog. 
 

Ø ‘Data to send’: Displays the data to be sent by the user to the other module. 
The red dot indicates the status of the communication: it goes to green when a 
message is being sent. 

 
Ø ‘To [Client/Address n]’: Indicates to which client or modem the frame is to be 

sent 
 

Ø ‘Frame length’: Provides the length of the frame to be sent by the user. 
 

Ø ‘Send continuously’: Enabling this option allows the user to transmit data 
(from ‘Data to send’) permanently to the other modem. The time out (i.e. 
‘Each […] ms’ field) is configurable but should be greater than 500 ms. 
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Ø ‘Auto reply’: Enabling this option allows the user to send every received frame 
back to the transmitter. 

 
Ø ‘Nb msg sent’: Provides the number of messages sent to the other module. 

 
Ø ‘Elapsed time’: Specifies how long the modem has been transmitting when the 

send continuously option is enabled. 
 

Ø ‘Send’ button: Sends the frame previously entered by the user in the ‘data to 
send’ field to the other module. 

 
Ø ‘Clear Send’ button: Clears the ‘data to send’ field as well as the ‘received 

data’ field of the other module. 
 

Ø ‘Stop’ button: Stops a permanent transmission (when ‘send continuously’ is 
enabled). 

 
 

The two other buttons at the bottom of the window are general for both 
modules: 

 
Ø ‘Display’ button: Displays a summary of the dialog established between the 

two radio units: 
 

 
 

Ø ‘Clear All’ button: Clears all the window’s fields (described above). 
 

Ø ‘Exit’ button: Quits the network dialog window. 
 
 

• Acquisition process 
 

When using the dialog tools with Spread Spectrum units (i.e. B/M900SS-xxx, 
B433YY-10), an acquisition step needs to be executed in order to determine the 
operation mode of each modem (i.e. Slave/Master or Client/Server, as well as ID 
numbers). This acquisition step requires given configuration of modules. In 
advanced user level configuration, those configurations have to be done directly 
by the user on the module as advanced user level does not feature a quick 
configuration tool. 
 
Please refer to the Peer-to-Peer Dialog chapter for a detail of the acquisition 
process. 
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CHAPTER IX.  TERMINAL 

 
Another tool available with the MTC software is the terminal. It is equivalent to 
an advanced terminal emulation program and can only be operated in advanced 
user level configuration. As many terminal programs, it allows operating within a 
given radio module through serial link, i.e. it allows communications, registers 
handling, network management and test functions.  
Therefore, Hayes mode should be mostly used inside the terminal but data 
frames can also be transmitted.  

 

IX.1. TERMINAL TOOL 

 
From the menu bar, the ‘Tool/Terminal’ submenu has to be selected. It can also 
be selected from the tool bar. The following window is displayed, allowing the 
user to choose on which port the terminal has to be operated: 
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Once the user validates the choice, the following terminal window is displayed: 
 

 
 

The different fields and buttons are listed below: 
 

Ø ‘Dialog on serial link’: This field contains all the data flowing between the 
module and the software (user), i.e. the data (or commands) sent to the 
module as well as the module’s answers. 

o Hide CR-LF : If this box is checked, the blue CR (Carriage Return) and 
LF (Line Feed) will no more be written. The text will still show the 
effects of the CR by going to the beginning of the next line. 

o Hide Nb Char : If this box is checked, the number of received characters 
will no more be displayed. This value is useful for tests to verify the 
frame length. 

 
Ø ‘Data to send’: This field contains the data to be sent to the module by the 

user. 
 

Ø ‘Open port’ button: Opens the serial port to which the module is connected and 
therefore enables communication with the module. 

 
Ø ‘Close port’ button: Closes the serial port to which the module is connected 

and therefore disables communication with the module. 
 

Ø ‘Clear’ button: Clears ‘Communication data’ and ‘Sent Data’ fields 
 

Ø ‘Exit’ button: Quits the terminal window. 
 

The last part of the terminal window (free field below the ‘Sent Data’ field) is the 
area in which functions buttons (for Hayes commands) can be defined with the 
terminal configuration window (See following paragraph) in order to simplify the 
terminal operation. 
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IX.2. TERMINAL CONFIGURATION 

 
 In order to simplify the use of the terminal tool, function buttons can be 
defined and implemented through a second tool, the terminal configuration tool. 
The terminal configuration tool can be displayed either from the menu bar or 
from the tool bar. 
 

• Operation Principles 
 

From the menu bar, the ‘Tool/Terminal configuration’ submenu has to be 
selected. A window allowing the user to choose on which port the terminal 
configuration tool has to be operated is displayed.  
 
Once the choice is validated by the user, the following terminal configuration 
window is displayed: 
 

 
  

The different fields and buttons are described below: 
 

Ø ‘KEY’: Lists the name of the buttons which Hayes commands. They are defined 
in the ‘COMMAND’ field. 

 
Ø ‘COMMAND’: Lists the Hayes commands corresponding to the buttons defined 

in the ‘KEY’ field. 
 

Ø ‘key’: This editable field must be filled with the name of the button the user 
wants to define (e.g. Hayes Mode) 

 
Ø ‘command’: This editable field must be filled with the Hayes command 

corresponding to the button the user wants to define (e.g. +++) 
 

Ø ‘hexa’: This editable field must be filled with additional hexa characters 
alternatively needed by some Hayes commands (e.g. ATO needs <CR> => 
hexa character is ‘d’) 

 
Ø ‘Add’ button: Adds the key and corresponding Hayes command defined by the 

user in the ‘key’, ‘command’ fields to the configuration 
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Ø ‘Add hexa’ button: Similar to the ‘Add’ button. To be used when a Hayes 
command requires an additional hexa character 

 
Ø ‘Edit’ button: Edits an existing button for its modification 

 
Ø ‘Remove’ button: Removes a selected button previously defined by the user 

 
Ø ‘Remove all’ button: Removes all the buttons previously defined by the user 

 
Ø ‘Load’ button: Opens a previously defined configuration 

 
Ø ‘Save’ button: Saves the current configuration 

 
Ø ‘Exit’ button: Quits the terminal configuration window 

 
 

 

•  Configuration Example  
 

The below example describes the implementation of two common terminal 
buttons: one to toggle to Hayes mode (command is ‘+++’), and one to toggle 
back to operating mode (command is ‘ATO<CR>’). 

 
1. Enter the name to give to the button in the ‘key’ field: In Hayes Mode  

 
2. Enter the corresponding command in the ‘command’ field: +++ 

 
3. Press the ‘Add’ button. The ‘Hayes Mode’ button is defined and is displayed in 

the ‘KEY’ and ‘COMMAND’ fields: 
 

 
 

4. Enter the name to give to the second button in the ‘key’ field: Return to work  
 

5. Enter the corresponding command in the ‘command’ field: ATO 
 

6. Enter the additional hexa character (<CR> is ‘d’) in the ‘hexa’ field: d 
 

7. Press the ‘Add hexa’ button. The additional character appears in the ‘command’ 
field: 
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8. Press the ‘Add’ button. The ‘Out Hayes Mode’ button is defined and is displayed 
in the ‘KEY’ and ‘COMMAND’ fields: 

 

 
 

The buttons are then available in the terminal window and can be used as 
commands: 

 

 
 

Several terminal configuration files are already set-up and stored in the ‘data’ 
directory of the MTC.  
Those, files are accessible via the ‘LOAD’ button in the Terminal configuration 
window.  
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CHAPTER X.  RADIO MODULES CONFIGURATION 

 
This chapter concerns the radio module configuration. The following paragraphs 
detail all the possible actions to be operated on module’s configuration: 

Ø Handling, consulting, modifying a connected modem’s configuration 
(chapters X.1 & X.2). 

Ø Creating configuration files to be assigned to connected modules  
(Chapters X.3 & X.4). 

  
 

X.1. DISPLAYING A CONFIGURATION 

 
The first and simplest action to be performed through MTC software is to display 
radio module’s configuration files, either from a connected module or created 
and defined by the user. 
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• Displaying A Connected Radio module Configuration 
 

In order to configure a connected modem, its configuration file needs to be 
displayed. A double-click on the connected module name (top part of the ‘Tree’ 
window) displays the corresponding configuration file (example below is for a 
M/B868MC-power modem): 

 

 
 

The window displayed depends on the modem type as they all have different 
parameters.  
The window is composed of several panels corresponding to parameters 
categories (E.g. Serial link parameters, radio link parameters, etc). The values 
displayed in the different fields of the configuration file window correspond to 
the modem’s current configuration. 
 
The configuration file windows can also be displayed from the tool bar. 
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• Displaying A Pre-Defined Radio module Configuration 
  

Configuration files can be created and defined by the user or can be pre-defined 
in the system and configurable. They should be saved in a configuration 
directory and should therefore appear in the bottom part of the ‘Tree’ window as 
described in chapter V.  

 
Ø From the ‘Tree’ window, a double click on the chosen configuration file name 

displays its window.  
Ø From the menu bar, the ‘File/Open’ submenu has to be selected. A browse 

window, named ‘OPEN’ is then displayed to allow the user to choose which file 
has to be open and displayed. 

 

X.2. CONFIGURING A RADIO MODULE 

 
The second action to be performed on radio modules is the actual configuration. 
Every connected radio module detected by the software during auto 
configuration can be configured through its parameters. The configuration can 
concern either a few parameters or all of them. Several possibilities can be used, 
depending on the data to be modified. 

 

• Modifying A Few Configuration Parameters 
 

If only a few parameters need to be modified, the configuration can be operated 
directly inside the radio module.  
 
Once the configuration file is displayed (see chapter X.1), the user has to select 
the panel corresponding to the data to be modified. Each parameter can be 
modified through the corresponding field (either editable or containing a pre-
defined list of values).  
 
Once a new value is entered in a field, the modification has to be validated by 
pressing the ‘APPLY’ button. For the editable fields, if the value entered by the 
user is invalid or out of range, a message like the following is displayed 
(example is for the filling rate parameter): 

 

   
If a value requires another register to be changed previously, the following 
message is displayed: 

 
 

Clicking on ‘No’ aborts all changes 
Clicking on ‘Yes’ cancel the forbidden modification but validate the other 
modifications. 
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• Modifying A Whole Configuration 
 

If the whole configuration has to be modified, it is equivalent to load a new 
configuration in the radio module.  This action is to be performed from the ‘Tree’ 
window. 
 
In the ‘Tree’ window, a right click on the port; to which the module to be 
configured is connected, displays a pop-up menu.  To load a configuration file, 
the ‘assign’ submenu has to be selected. A browse window is then displayed, 
allowing the user to choose the file to assign to the radio module.  The chosen 
file then appears as a child node of the serial port node and its window is 
displayed (See chapter V ) 
 
The same operation can be done with a simple ‘Drag & Drop’ (mouse left click). 
The configuration file has to be selected from the bottom part of the ‘Tree’ 
window, and then dragged and dropped on the radio module’s icon in the top 
part of the ‘Tree’ window. The chosen file appears as a child node of the serial 
port node and its window is displayed. 
 

 
 
 

X.3. CREATING A NEW CONFIGURATION FILE 

 
As shown already, the user can create a configuration file at any time. This 
operation can be performed either from the ‘Tree’ window or the menu bar. 
 

• From the Tree Window 
 

 As described in chapter V, the configuration files are stored in the bottom 
part of the ‘Tree’ window and sorted by radio module type. In order to create a 
particular module type configuration file, that module type has to be selected in 
the ‘Tree’ window.  A right click then displays a ‘new’ pop-up submenu. To 
create a new configuration file, that submenu has to be selected. A browse 
window (named ‘NEW’) is displayed, allowing the user to give a name to the file 
to be created. 

 
Ø If the given name already exists, the following message is displayed: 

 
 

Ø If the given name does not have the proper extension, the following message 
is displayed: 
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Ø If the file can not be created for any reason (e.g. use of wrong characters), a 
message like the following is displayed: 

 
 

Ø If the given file name is validated, the file is created and its window is 
displayed with the default values of the radio module type: 

 

 
 
 
 

The file is then created but not validated. For the file to be validated, i.e. to be 
stored in the bottom part of the ‘Tree’ window, the ‘APPLY’ button has to be 
pressed. The following message is displayed: 

 
 

Once the creation is validated (‘Yes’ pressed), the new file appears in the bottom 
part of the ‘Tree’ window: 
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• From The Menu Bar 
 

As described in chapters III.2 and IV.2, the submenu to be selected for a file 
creation is the ‘File/New’ submenu. The following window is displayed, allowing 
the user to choose either the type of modem for which the configuration file has 
to be created or the serial port to be configured: 

 

 
 

Once the selection is made, a browse window (named ‘NEW’) is displayed, 
allowing the user to give a name to the file to be created. Once the given name 
is validated (see previous paragraph for invalid name cases), the file is created 
and its window is displayed.  
 
As described previously, the file has to be validated by pressing the ‘APPLY’ 
button. Once validated, the file appears in the bottom part of the ‘Tree’ window. 

 
  

A file can also be created from the tool bar (See chapters III.3 and IV.3) 



Radio Modules Configuration 45  
 

 

 
 

X.4. SAVING A CONFIGURATION 

 
Once configuration files has been created or modified, they obviously can be 
saved from the tool bar or from the ‘File’ menu of the menu bar. The ‘Save’ 
submenu allows to save an existing configuration file while the ‘Save as’ 
submenu allows to save the current file as a new configuration file. 
 

• Saving An Existing Configuration 
 

When a file has been modified, the modifications have to be saved into the 
configuration file. While the configuration file window is displayed, the ‘File/Save’ 
submenu has to be selected.  
 

Ø If the file does not exist or is not defined, the software toggle to a ‘SAVE AS’ 
browse window, allowing the user to give a name to the file. 

 
Ø If the file exists and is already defined, it can be saved at any time, and the 

following confirmation message is displayed: 
 

  
 Pressing ‘Yes’ saves the file as defined. 

 
 

• Saving As A New Configuration 
 

 When a file has been created by the user, it has to be saved in the 
configuration file directory. While the configuration file window is displayed, the 
‘File/Save as’ submenu has to be selected. A ‘SAVE AS’ browse window is then 
displayed, allowing the user to give a name to the new configuration file. 
 

Ø If the file name does not have the right extension (or no extension), the save 
action is aborted and the following message is displayed: 

 
 

Both ‘Save’ and ‘Save as’ functions can be operated from the tool bar (See 
chapters III.3 and IV.3) 
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Ø If the file already exists, the following message is displayed: 

 
 

Pressing ‘No’ aborts the save action, while pressing ‘Yes’ displays the 
confirmation message. 

 
 

Ø If the file name does not exist and is valid, the file can be saved and the 
following message is displayed: 

 
 

Pressing ‘No’ aborts the save action, while pressing ‘Yes’ displays the 
confirmation message. 
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CHAPTER XI.  PROGRAMMING 

 
The last operation available with MTC Workbench is the programming: Nearly all 
One RF modems can be re-programmed for firmware upgrade.  
 
   
From the menu bar, the ‘Programming\Flashing’ submenu is to be selected. The 
following window is displayed: 

 

 
This window allows the user to choose proper serial port, file type (only Hexa 
files are available for customers) and the modem type.  
Once the choice is made in all corresponding fields, click on the ‘START’ button. 
 
An intermediate window shows the specific hardware configuration needed for 
the used module before starting : specific cable, switches setting,... 
 
When set, click on "Continue" 
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The following programming window is displayed, showing the programming 
status: 

 

 
 

Once the flashing is done, the ‘CLOSE’ button is enabled and closes the 
programming window. 
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